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1.0 Introduction 
 
Mixers may be connected to the TM1 either via a serial link, TCP/IP or via the parallel input 
D37 connector depending on the mixer. 
 
In TallyMan, the mixer may treated exactly as though it were a router.  However, some 
simpler mixers output parallel tally information only and so mixer router status is not available. 
 
As the mixer may be treated as a router, UMDs may be assigned to sources as well as 
destinations (Buses).  
 
Normally, it might be assumed that mixer tallies are used directly to indicate which source is 
on-Air. 
 
Where a mixer does not have a Tally In interface in TallyMan, a permanent tally (a System 
Tally) must be set to the bus, PGM, PST or whatever is required,  Sources will be tallied as 
long as the mixer manufacturer outputs the bus information required. 
 
As in a router, a tally set to a destination or bus will tally the source that is selected by that 
destination.  This is a use for an ON System Tally. 
 
Many mixers now support source button names.  TallyMan allows a choice to be made of the 
sources for these names which may derived from a router or may be a fixed name. 
 
 
 
Notes 
 
The Tally In modules for some mixers are there in order that you can, if you wish, use the 
mixer tally controls to decide what tallies are generated. 
 
Alternatively you can ignore them, and still allocate a Program System tally as long as router 
status is transmitted to TallyMan.    
 
Where mixer manufacturers give a comprehensive protocol, both options apply.  
 
In the case of the DD35, using ACOS protocol gives information on what sources are on what 
busses but does not give mixer derived tallies or Key/ME contribution information. Recent 
Thomson mixers output tally data via a TCP/IP link. 
 
Vision Mixers are treated as routers in TallyMan.  If a Router Destination feeds the input to 
the Mixer,  the Mixer Source should be assigned to the Router Destination. Cameras will 
normally be inputs to the Router so physical output pins may be assigned to these router 
inputs.  The camera CCUs will get a tally via the mixer-to-destination-to-router source-to-
output pins mapping. 
 
Where the Router is a monitoring router for the picture monitors and the cameras are fed to 
both to the Router Inputs (Sources) and to the Mixer Inputs (Sources ), Mixer Source to 
Router Source mapping should be carried out.  Physical output pins for the camera CCUs 
should still be assigned to the Router Sources. 
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Also some mixer only output serial tallies with no router status.  These protocols will be found 
in the I/O module, similar to the default Parallel one seen on the TMx platforms. 
 
 
E.G.  A Tally I/O module set for a FOR-A mixer 
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2.0 Adding a Vision Mixer  
 
Click on Add New Component on the main screen. 
 

 
 
From the Add New System Component list select Mixer or I/O as appropriate. 
 

  
 
 
 
 

  

When a new 
component is 
added to the 
system it must be 
given a Name 
before the OK 
button becomes 
active. 
 
This Name will be 
seen in the 
system tree on the 
left side of the 
screen. 

The Mixer type is 
selected from the 
drop down box 
and here is shown 
as type GVG 
Kalypso.  Press 
Apply. 
 
The Size will be 
set for some 
mixers – if they 
are not set enter 
the appropriate 
number in the 
Size box. 
 
The Mixer 
Sources and 
Destinations are 
seen in the LH 
column. 
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When the Mixer type has been set press Apply.  The program will now jump to the Main 
Communication box in the Assign Interfaces area. 
 
 
2.1 Assign Interfaces – Main Communication 
 
The Mixer communications must now be set up.  Select the Type.   
 
Select the Port Number that the computer will use to communicate with the Mixer.  Give it a 
Description. 
 
The Serial Parameters will usually be automatically entered where this is known by TSL. 
 

 
 
On clicking on OK the main system screen will be shown. 
 

 
 
The sources and destinations may now be edited as required.
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3.0 Mixer Sources 
 
A Click on the Source will show this dialog box. 
 

 
 
 

  
 
 
3.1 Mixer Button Display Assign 
 
The Mixer (panel) Label can be taken from:  
-the Fixed box (Shown with the text Input 1)   
-or via the Router mapped sources – set below in the Assignment box.   
 
The recursive level must be set – 1 is back to the first destination, 2 is set to the source 
feeding that destination etc. 
 
-or from the Mnemonic set in the box near the top with the green characters. 
Take 2+2 will take the first 2 and last 2 characters. 
 
 

A double click 
on a Source 
field will bring 
up this dialog 
box. 
 
The Name box 
is only an aide 
memoir. 
 
The Mnemonic 
box shows 
what would 
appear on a 
UMD assigned 
to, say, the 
PGM output 
when this 
source is 
selected. 
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Notes 
 
The mixer panel names are enabled via the screen: 
 

 
 
 
Select Configure Mixer Names. 
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3.2 Assignment 
 
The mixer source may be mapped to  
 
A router/mixer source – source to source mapping 
A router destination – source to destination mapping 
 
UMDs associated with the mixer and the mixer panel labels will reflect this mapping. 
With source to source mapping a Separate Mnemonic may be set for any UMD which is the 
Mnemonic shown on dialog box. 
 
3.2.1 Assign to Source 
 
Source to source mapping allows two sources to be linked together for tally purposes but the 
source mapped to is the controlling source for mnemonics. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When this option is selected in the Assignment box, the Display on the router output  will 
show the mnemonic of the assigned source. Tallies may be derived from either the assigned 
source and/or from the original source.  In this example, “CAM 1” will be shown, assuming 
that the Router 1 Bus has selected its input, SRCE 193. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The mnemonics for the input to Router 1, SRCE 193, are effectively taken over by the input 
mnemonics of the mixer.  The router input will also be tallied by the mixer source as 
previously described. 

  
For a Router             

Router 1 
Lines 

Router 

 
Mixer 

 

CAM 1 

CAM 
1 

SRCE 193 

TallyMan Link 

 
For a Mixer 
 
 
 
 
 
 
 
 
 
 
 
The panel will display VTR+TC unless Separate Mnemonic is checked.  If the destination or a source is tallied, 
both VTR sources will be tallied.   
 
 

VTR 
 
 
Time Code o/p 

Source to Source 
Mapping 

VTR 

VTR+TC 

MXR Panel 
Mixer 

 

SRCE 193 is mapped to 
the Mixer 
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Conversely, the mixer inputs could be mapped to the inputs to the router.  In this case the 
mixer’s mnemonics would be those entered for the router sources.  As tallies add, the router 
sources would be tallied by the mixer source. 
 
It is important to remember that the source that you are assigning to is the controlling 
mnemonic source.   
 
 
3.2.2 Assign to Destination. 
 
This is used when a router destination is linked to the mixer input and UMDs need to show 
the correct original source mnemonic. 
 
 
 
 
 
 
 
 
 
 
 
 
A display on a Mixer Bus or button legend needs to show the correct Router 1 source 
mnemonic.  A display could be associated with the PGM Bus. 
 
In the example above, the Mixer has a UMD on its PGM Bus.  Input 1 on Router 1 has the 
mnemonic “CAM 1”.   
 
Mixer input 1 is connected to Router 1, Bus 161, (which has the mnemonic “DST 161”).  
Router  1 will have mnemonics assigned to it’s sources.  It is these source mnemonics that 
will be shown on the Mixer Bus Display.  
 
Therefore, the linking will now ensure that Mixer Bus Display shows the correct Router 1 
Source mnemonic which is selected by Router 1, Bus161. 
 
The Mixer sources will be tallied, as will the Router destination.  This will, in turn, will tally the 
selected router source.  This tallied router source may be mapped to a physical output pin to 
get tallies out to the cameras. 
 
 

  
     

Router 1 
Lines 

Router 

 
Mixer 

CAM 1 
DST 161 

CAM 1 
SRC 1 

TallyMan Link 
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If there are several routers in the system the recursive depth may be set.  This shows that the 
recursive depth is set to maximum. 
 

   
 
 
 
For example, if there are two cascaded routers in the system, the Mixer names may be taken 
from either the first router’s sources lists or from the second router’s source lists, depending 
on whether 1 or 2 is set in the box. 
 
3.3 Repeat Edit  
 
This will allow quick automatic incrementation of mixer sources and the Auto Copy will carry 
on down the same settings for the next mixer source. 
 
3.4 Allow User Configuration 
 
If this box is checked this dialog screen will be accessible from the User settings. 
 
3.5 Category 
 
Mixer sources may be assigned to one of seven categories to assist editing later. 
 

The Source is 
assigned to the Main 
Router with the 
Destination 
Mnemonic shown as 
Output 1. 
 
Any UMD assigned 
to the Mixer’s 
destination will show 
the Router’s source 
mnemonics. 
 
 

The Mixer Button 
Display may be 
taken from the 
Router Names lists.   
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3.6 Direct Tallies to Source. 
 
 

  
 
 
 

  
 
 

• The tally Type must be selected. 
• The Parent source must be selected. 
• The actual Tally must be selected. 
• and then Added to the box. 

 
For mixers with parallel tally outputs, the tallies will be connected to a Parallel I/O unit and 
direct tallies may then be mapped to the mixer sources,  

A click on the Direct 
Tallies In button will 
show this box. 
 
A Tally (or tallies) 
may be assigned to 
the mixer 
destination. 
 
This shows that a 
System Tally has 
been assigned to 
Source 1. 
 

Direct Tallies to 
Source  
 
Tallies from an I/O 
module may have its 
tallies mapped to the 
source(s) if required. 
 
This shows a tally 
has been assigned 
from a Parallel I/O. 
 

Category  
The Source may be 
categorised, if 
required, to allow 
editing by category. 
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4.0 Mixer Destinations 
 
Clicking on the Destination will show the following screen. 
 

 
 
 
 

   
 
 
 
4.1 Mixer Label 
 
This is the name which may be offered to a mixer button when the selection set in 3.2.1 Mixer 
Button Display Assign is made for a router. 
 
The Mixer (panel) Label can be taken from:  
 
-the Fixed box (Output 1)   
-or from the Mnemonic set in the box near the top with the green characters. 
Take 2+2 will take the first 2 and last 2 characters. 
 

The Name box is 
only an aide 
memoir. 
 
The Mnemonic 
box shows what 
would appear on a 
UMD assigned to 
a mixer source 
when this 
destination selects 
that source. 
 
Allow user 
configuration box 
allows the User to 
modify this 
screen. 
 
Delete Selection 
will allow removal 
of tallies 
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Notes 
 
The mixer panel names are enabled via the screen: 
 

 
 
 
Select Configure Mixer Names. 
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4.2 Priority  
 
This is only required to be set for UMDs assigned to the Sources.  Priority 1 is the top priority. 
 
It is possible for a mixer/router source to be selected by several buses at once.  A priority 
needs to be set for the router buses so that any Display attached to the router source will 
show the desired bus mnemonic.   
 
4.3 Repeat Edit  
 
This will allow quick automatic incrementation of mixer sources and the Auto Copy will carry 
on down the same settings for the next mixer source. 
 
4.4 Category  
 
The Destination may be categorised, if required, to allow editing by category. 
 
4.5 Direct Tallies In 
 
Tallies from the Mixer to the rest of the system. 
 
If there is no mixer parallel Tally In module associated with the mixer, it is very important that 
a tally (a permanently ON System Tally) is assigned to the Destination(s), for tallies to appear 
at the mixer source when that source is put to air.  TallyMan reads the router information from 
the mixer and uses this as information as to which source is on air.  
 
For mixers with parallel tally outputs, the tallies will be connected to a the Parallel I/O unit and 
direct tallies may then be mapped to the mixer sources,  
 
The tallied mixer source may then be mapped to a router destination for the UMD to show the 
correct tally state and also to a Parallel I/O unit for output to the cameras.   
 

--------------------------- 
 
In this example a permanently ON System Tally has been set to the PGM mixer destination 
which will, in turn tally the sources that the PGM destination selects.  So, in other words, any 
source put to air will get a tally. 
 
Overview of a typical tally path. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Mixer source will be tallied; this will tally the Router Destination feeding that Mixer 
Source; the Router Source will be tallied. 

  PGM Bus with a 
permanent 
System Tally 

Router 

Mixer 
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Tallies may then be output via the Parallel I/O interface for the camera red lights etc. by 
assigning a router source to a physical output pin. 
 
A UMD assigned to any point in the path which is On-Air will show a tally assuming that the 
UMD mask has been set to show the Active Tally Channel. 
 
Please see the UMD and Tally Sections for more details. 
 
 
5.0 Using other programs to edit the Mixer source and destination lists. 
 
5.1 Copying Names and / or Mnemonics  
 
If the mixer sources or destinations are selected and copied (RH mouse button or via Edit > 
Copy Mnemonics or Edit > Copy Names) the text may be downloaded into other applications 
such as Microsoft Excel.  No delimiters should be checked for vertical filling.  Various 
delimiters are available for loading into other programs. 
 
 

  
 
 
Open Excel and mark the first box.  Click on Paste and the Names or Mnemonics will be 
entered. 
 
5.2 Pasting Names and Mnemonics into TallyMan. 
 
Lists may be created in other programs, such as Microsoft Excel and pasted into TallyMan. 
 
Mark the list and copy to the Clipboard.  Open TallyMan and paste into the Names or 
Mnemonics list as required. 
 
6.0 Tools > Router Mimic 
 
When the program is on-line and this box is displayed, mixer-router communication may be 
observed.  This facility should be used to check for correct communications. 
 
 

The edit menu allows 
copying or pasting of 
the Mnemonics and  / 
or Names 
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7.0 View > Options 
 
The facility is now offered whereby the drop down lists may show either the Name or the 
Mnemonic associated with the router, for example.  The Index number may also be shown, if 
required. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This shows the Index number and the Name
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This shows the Index number and the Mnemonic. 
 
 
 
 
 
 
 
 
 


